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�Introduction
FirstClass® Migrator for Microsoft® Exchange Server (FirstClass Migrator) is a two-part utility that migrates user accounts, public folders, distribution lists, and mailbox content from Microsoft® Exchange Server to FirstClass. 
The server-side utility, FirstClass Migrator for Microsoft Exchange Server, duplicates: 
•	Microsoft Exchange Server accounts as regular users within FirstClass
•	Microsoft Exchange Server public folders as public conferences that reside on the FirstClass administrator's Desktop
•	Microsoft Exchange Server distribution lists as mail lists in the FirstClass Directory. 
You can migrate all of the information at once, or you can select the information you wish to migrate. 
The client-side utility, FirstClass® Migrator for Microsoft Outlook®, migrates mailbox content from Microsoft Exchange Server to FirstClass. It migrates one or several personal message stores (appearing as .PST files) and the user's Microsoft Exchange Server mailbox (located within Microsoft Exchange Server's private message store) into an individual's FirstClass account. It can be used individually, or combined with FirstClass Migrator. When combined, the recipients of the migrated messages can be represented by their corresponding FirstClass names, as long as the names were migrated by FirstClass Migrator first. For more information about the client-side utility, see Appendix A: Migrating user information from Microsoft Exchange Server to FirstClass using FirstClass® Migrator for Microsoft Outlook® or the HELP.TXT file that installs with FirstClass Migrator. 
Who should read this book
This book is intended for the FirstClass administrator who will perform the migration on user accounts, public folders, and mail lists. 
What you will find in this book
This book describes how to install and use FirstClass Migrator and FirstClass Migrator for Microsoft Outlook . It also lists the installation requirements of each and discusses current considerations of FirstClass Migrator. 
This book does not document how to use FirstClass or Microsoft Exchange Server features. For that information, see our online help and applicable product documentation. 
What you should already know
This book is intended for administrators who want to copy their Microsoft Exchange Server information into FirstClass format. We assume you are familiar with your Windows® operating system, Microsoft Exchange Server, and FirstClass functionality.

�Requirements
FirstClass Migrator can be installed on any machine that can reach both the Microsoft Exchange Server and the FirstClass server simultaneously. 
Note
We do not recommend installing FirstClass Migrator on the same machine as the Microsoft Exchange Server.
Minimum installation requirements for FirstClass Migrator:
•	Microsoft Outlook 97 with Internet Explorer 5.0 or Microsoft Outlook 2000 installed 
•	Windows NT 4.0 SP6 (recommended), Windows 2000, or Windows 9x/Me for small-scale migration 
•	128 MB RAM
•	66 MHz Pentium processor (233 MHz processor recommended)
•	Privileged access to Microsoft® Exchange Server 5.5 and the Microsoft Exchange Server resources
•	Privileged access to the FirstClass server as the administrator through TCP/IP.

�Installing FirstClass Migrator
This section describes how to install and configure FirstClass Migrator.
Application considerations
To ensure a successful migration:
•	Never run two instances of FirstClass Migrator simultaneously. FirstClass Migrator will prevent two instances of the application running on the same computer, but it is your responsibility to make sure there is only one instance running on the network. 
•	Always try to run FirstClass Migrator from the same computer because the program settings are saved locally on the computer where FirstClass Migrator is installed. 
Note
This may not be possible in a multisite environment. 
Multi-site environments
If you have a multisite environment:
•	Make sure additional installations of FirstClass Migrator are configured the same as the first installation, and try to use computers which can access the individual Microsoft Exchange sites locally. This will improve the efficiency of the migration.
•	Currently, only on-site migration is supported for mailboxes and distribution lists. That is, when you log onto a specific Microsoft Exchange site, only the mailboxes and distribution lists native to that site can be migrated. To migrate mailboxes and distribution lists on other sites, you must switch to those sites to perform the migration.
•	We strongly recommend that all of the migration of public folders be performed from within a single Microsoft Exchange site. If you have to change sites to perform some public folder migration, make sure the two sites (the original Microsoft Exchange site and the Microsoft Exchange site you are switching to) have been fully replicated and synchronized before launching the migration on the new site.
•	Multiple log messages may be created under each public folder in a mulisite environment. Their purpose is to store migration status log information for their parent public folder. They are automatically maintained by FirstClass Migrator and are not migrated to a corresponding FirstClass conference during migration. Do not edit them or delete them manually, or the log information stored in them may become corrupt or lost. 

Installation
To install FirstClass Migrator:
1	Insert the FirstClass Migrator for Microsoft Exchange Server CD into the CD-ROM drive.
If the application doesn’t load automatically:
a	Select Run from the Start menu.
b	Type 
drive:\fcms.exe
where drive is the letter of your CD-ROM drive.
2	Follow the prompts.
After the FirstClass Migrator is installed, you must establish connections with the Microsoft Exchange Server system and the FirstClass system. 
To establish a connection with the Microsoft Exchange Server system:
1	Log into the Windows NT domain as the administrator.
2	Create a new MAPI profile to allow you to access the Microsoft Exchange Server system. 
The Microsoft Exchange Mailbox you choose to connect to must be native to the Microsoft Exchange site you are migrating from. 
3	Verify your access to the Microsoft Exchange Server system using Microsoft Outlook by logging into the Windows NT domain as a privileged account (requires administrator privileges for Microsoft Exchange Server as a minimum). 
Note
You must log into a Microsoft Exchange Server account with administrator rights at the organization level, server level, and site level.
To establish and validate a connection with the FirstClass system:
1	Log into FirstClass as the administrator using the FirstClass client.
2	Make sure you have full read/write access to the FCPO directory from your computer. 

�Migrating server information
Warning
When you migrate user accounts, you are actually creating regular users on the FirstClass server, so it is important to make sure you have enough FirstClass licenses to add these new users. If you do not have enough licenses, some of the accounts may fail to migrate. 
Warning
When running FirstClass Migrator, make sure Microsoft Exchange Server is running. Otherwise, you will receive an error when you attempt to use FirstClass Migrator.
When you migrate public folders, you are creating a conference in Conferences on the administrator’s Desktop called All Public Folders, that contains the entire folder tree.
To migrate server information, including user accounts, mail lists and public folders:
STEP 1: Configure FirstClass Migrator.
STEP 2: Synchronize Microsoft Exchange information.
STEP 3: Select the information to migrate.
STEP 4: Migrate the information.
STEP 1: Configure FirstClass Migrator
1	Start FirstClass Migrator and log into Microsoft Exchange Server with a proper MAPI profile.
2	Choose Edit > Settings, or click Settings:
.
[Image:29012002_105828_0.png]
Double-click to enlarge:
[Image:29012002_105841_1.png]
3	Enter the following information on the FC Connection tab:
FirstClass Server Name or IP Address
Enter the IP address of the FirstClass server. If the server is on the same machine you are on, enter "localhost".
Proxy IP Address
This value is always 0.0.0.0. The proxy pod value is usually 1080. If it is not, enter the appropriate value.
FirstClass Administrator Account ID
Enter the administrator’s account name. 
Double-click to enlarge:
[Image:29012002_105948_2.png]
4	Enter the following information on the Migration tab:
Working Directory
This is where temporary files will be stored. Usually C:\TEMP is an acceptable value.
Log Directory
This is where log files and associated text files will be stored.
FCPO Directory
If the FirstClass server is on the same machine, enter the path where the FirstClass Post Office is located (usually C:\FCPO). 
If the FirstClass server is on a separate machine, you must share the FCPO drive on the FirstClass server and map to it on the current machine.
Initial Mailbox Size
Enter the size Mailboxes will be upon creation.
Migration Mode
Batch Mode: Ensures name uniqueness; automatically adds a suffix to the name if necessary (the FirstClass administrator can change this name after migration if desired; name modification will not affect migrator operations because migrator uses Client ID, not name, for identification)
Interactive Mode: Prompts you with a dialog box to enter a name; if it is not unique, you will continue to receive dialog popup boxes until you enter a unique name
Note
We recommend Batch mode for convenience.
5	Click OK.
Note
You must restart the application for changes to take effect.
STEP 2: Synchronize Microsoft Exchange information
Before you start the migration process, you must make sure the objects (mailboxes, directory entries and public folders) in Microsoft Exchange are fully synchronized to keep the log information consistent. It is important that this log information be accurate, as it provides FirstClass Migrator with the most updated information about these objects. 
It is your responsibility to configure Microsoft Exchange to perform a proper synchronization. For details about performing a full synchronization in Microsoft Exchange, see the relevant Microsoft Exchange documentation. 
Microsoft Exchange is usually configured to automatically synchronize based on a schedule. However, if you choose to switch sites to migrate information before the automatic synchronization has occurred, and you do not synchronize manually, you risk corrupting the migration status information.
STEP 3: Select the information to migrate
When you start FirstClass Migrator, you will see a screen similar to the following: 
Double-click to enlarge:
[Image:29012002_110053_3.png]
This is the Account view. It lists all of the usernames associated with the mailboxes native to the current Microsoft Exchange site, along with the full name and alias assigned to the mailboxes. The window on the right is where items are listed as they are selected.
This screen contains three windows: Account View, Distribution List View, and Public Folders View. You can toggle between these views using the corresponding button in the toolbar:
[Image:29012002_110140_4.png]Account View button
[Image:29012002_110147_5.png]Distribution List View button
[Image:29012002_110155_6.png]Public Folders View button
You will see checkboxes beside each object. These checkboxes represent an object’s migration status. On the Mailbox View and Distribution List View windows, if the items are checked, they have already been migrated (unchecked items were not migrated the last time FirstClass Migrator was run). If you select an unchecked object, it appears in the "To migrate" list on the right, in preparation to be migrated.
Shortcut
Use the toolbar buttons Check All and Uncheck All to quickly select or unselect all items at once.
[Image:29012002_110227_7.png]Check All button 
[Image:29012002_110239_8.png]Uncheck All button
On the Public Folders View window, you can check or uncheck items you wish to migrate at this time, regardless of whether they were migrated before. The items in this view can be toggled as desired. A checked object in the Public folder tells the application to migrate any new information for this object since the last migration. An unchecked item in the Public folder tells the application not to migrate the information at this time. However, previously migrated information will not be affected.
Note
FirstClass Migrator supports smart duplicate handling on public folders. This means public folders and their contents will not be duplicated if they are selected multiple times. 
STEP 4: Migrate the information
1	Run a complete Trash Collection in FirstClass.
	This ensures deleted items no longer exist within the FirstClass Directory. Do not delete any other Directory items after the Trash Collection until the desired migration process has completed. 
2	Select the items you want to migrate from the three views of FirstClass Migrator. 
3	Click Migrate.
	[Image:43002_32326_0.png]
4	Enter a valid password for the FirstClass server. 
5	Click OK.
At this point, FirstClass Migrator will send a batch admin command to retrieve information from the server. If the server is not running, you will receive a "Can’t find the FirstClass server" error.
If the status log information for Microsoft Exchange objects does not match the current status of the FirstClass Directory (for example, this may occur if some migrated objects on the FirstClass side have been deleted since the last migration), you will receive a "Log info lost sync" error. If this occurs, choose File > Sync Log, and then follow the steps again, starting at step 2.
While the migration is occurring, a blue progress bar on the bottom of the window will show the amount completed, and as each item is migrated, it will disappear from the "To migrate" list. 
After the migration has completed, you will receive a message indicating the migration was successful, or FirstClass Migrator "failed to migrate some accounts". If there was any problem with the migration of any object, you can view the results in the history logs. 
Note
The log files are saved as CSV (Comma Separated Values) files and are located in the Log Directory specified on the Migration tab of the FirstClass Migrator Properties window. These files can be manipulated with most standard database applications.
Account log 
[Image:29012002_110455_10.png]
The account log displays the account information that was migrated into FirstClass, including the migrated status and the reason for a failure, if any. It also notes the mail lists each user is a member of.
Double-click to enlarge:
[Image:29012002_110515_11.png]
Mail list log 
[Image:29012002_110521_12.png]
The mail list log displays the mail list information that was migrated into FirstClass, including the migrated status and the member list of the migrated mail list. It also notes the mail lists each migrated mail list is a member of.
Double-click to enlarge:
[Image:29012002_110549_13.png]
Conference log
[Image:29012002_110558_14.png]
The conference log displays the conference information that was migrated into FirstClass, including the migrated status and the action performed on the conference. It also notes the mail lists each migrated conference is a member of.
Double-click to enlarge:
[Image:29012002_110620_15.png]
Error messages and their meanings
Not processed. 
There was a problem discovered before migration started, so the accounts are untouched. 
Migration succeeded.
Migration was successful. 
Failed to migrate some accounts.
Migration was completed, but some accounts did not migrate correctly. The details can be found in the corresponding history log. 
Failed to create a new mail list. Migration halted.
Application cannot determine reason for error. Contact Centrinity Customer Support if restart does not correct the problem. 
Failed to get the ClientID of a newly created mail list. Migration halted.
Application cannot determine reason for error. Contact Centrinity Customer Support if restart does not correct the problem. 
Failed to get the ClientID of a newly created conference. Migration halted.
Application cannot determine reason for error. Contact Centrinity Customer Support if restart does not correct the problem. 
Failed to create a conference. Migration halted.
Application cannot determine reason for error. Contact Centrinity Customer Support if restart does not correct the problem. 
Error encountered. Migration halted.
Application cannot determine reason for error. Contact Centrinity Customer Support if restart does not correct the problem. 
Critical error occurred during migration. Migration halted.
Migration is not completed. Details can be found in the corresponding history log.
Nothing to migrate.
You did not select any new accounts, distribution lists or public folders to migrate.
Migration halted.
Any other errors which are not predictable will result in this (such as a broken connection).
All of the public folders are put into one conference called All Public Folders. This conference is located in Conferences on your Desktop. If you browse this conference, you will notice the paths remain the same as they were in Microsoft Outlook, and all of the associated messages and attachments are intact. 
Note
FirstClass Migrator ignores Undeliverable and automatically generated files, so these will not be migrated.
Public folders of appointment type or task type will be converted to group calendars instead of conferences in FirstClass.
All of the users you migrated become regular users in the FirstClass server. You must now migrate their personal content individually, or have them do it, following the instructions in Appendix A: Migrating user information from Microsoft Exchange Server to FirstClass using FirstClass® Migrator for Microsoft Outlook®. This information is also available in the HELP.TXT file that installs with the FirstClass Migrator application.

�Migrating client information
FirstClass® Migrator for Microsoft Outlook® (FirstClass Migrator for Microsoft Outlook) migrates one or several personal message stores (.PST files), and the user’s mailbox on Microsoft Exchange Server (located within Microsoft Exchange Server’s private message store) into an individual FirstClass account. It can be used by itself, or can be combined with FirstClass Migrator for Microsoft Exchange Server. When combined, the addressees within the user’s messages can be represented by their corresponding FirstClass names as long as their accounts were migrated first. 
Information on how to use the FirstClass Migrator for Microsoft Outlook is located in Appendix A: Migrating user information from Microsoft Exchange Server to FirstClass using FirstClass® Migrator for Microsoft Outlook®. This information is also available in the HELP.TXT file that installs with the FirstClass Migrator application.
However, as administrator, you need to prepare the users to be able to use the FirstClass Migrator for Microsoft Outlook  successfully by enabling batch admin functionality. You do this on the Multi-Site Setup form by selecting Allow batch administration and by setting the Batch administration password to "admin". It must stay this way until all of the users have copied their information from their Microsoft Exchange Server mailboxes into their FirstClass accounts.
[Image:29012002_110707_16.png]
Warning
Until Trash Collection runs, the migrated items will occupy double their actual disk space, as they exist in two locations. Because of this, make sure the amount of disk space allotted for each user is twice the amount you will actually need.

�Considerations
General considerations
•	FirstClass Migrator does not support RTF format in the body of messages. Instead, the plain text within the RTF body is extracted to form the FirstClass message body, and all of the embedded items within the RTF body become message attachments.
•	FirstClass Migrator does not support nested (embedded) messages. These are attachments that are created by dragging an existing message and dropping it into the message you are composing, or by choosing Insert > Item from the menu. Because there is no corresponding feature in FirstClass, FirstClass Migrator ignores it.
•	FirstClass Migrator does not support OLE attachments. These are created by dragging and dropping an OLE object from other applications into the message you are composing, or by choosing Insert > Object from the menu. Because FirstClass does not support object level attachments, and it is not practical to convert an OLE object into a file, FirstClass Migrator ignores the OLE attachment.
•	FirstClass Migrator does not support Reference attachments. These are attachments within the body of the message that only contain a fully qualified path identifying the attachment instead of embedding its real content into the message. These are created by choosing Insert > Files from the menu, or by choosing the "Insert as shortcut" option. Because FirstClass does not support this feature, and embedding the content of a huge file is not practical in most cases, FirstClass Migrator ignores it.
•	FirstClass Migrator does not support Meeting Request forms, Journal forms, or custom forms designed by the user.
•	If a message recipient has not migrated to FirstClass yet, their name will be replaced by an SMTP address; if an SMTP address does not exist for that recipient, the message recipient’s name field will be replaced with the default recipient (Administrator). The message itself will remain untouched in the original Mailbox.
•	FirstClass Migrator will truncate item names at 23 characters, and user IDs at 15 characters, before attempting to validate them.
Appointment considerations
•	FirstClass Migrator does not support resource-type participants (for example, location or equipment).
•	Because our FirstClass calendar does not currently support calendar exception, the calendar exceptions in Microsoft Exchange Server are mapped into FirstClass by dividing the original appointment into several parts. 
•	For example, In Microsoft Exchange Server, a weekly appointment is scheduled for every Thursday from April 6, 2000 to February 7, 2002, with one exception: the Thursday, June 14, 2001 meeting is rescheduled to Tuesday, June 12, 2001.
•	FirstClass will divide this entry into three parts: 
•	April 6, 2000 – June 13, 2001
•	June 12, 2001
•	June 21, 2001 – February 7, 2002.
If the exception of the original appointment is changed, so the last occurrence is moved from February 7, 2002 to February 10, 2002, the appointment will be divided into two parts:
•	April 6, 2000 – February 6, 2002
•	February 10, 2002.
•	The Calendar Exception "Occurrence Cancellation" on Microsoft Exchange Server is not currently supported. For example, referring to the original example, if there is a cancellation exception on Thursday, June 14, 2001, this exception will not be recognized when migrating.
•	Recurrence patterns are partially supported. All of the recurrence patterns supported by the FirstClass calendar will be mapped accurately, while the other patterns can only change into the supported patterns in a most reasonable way.
The details of this most reasonable mapping are listed below:
•	Every X days will change to daily
•	"Every Friday and Sunday" and so on (where at least one day is a weekend day) will change to daily and the event will occur every day
•	"Every Monday and Thursday" and so on (where both days are weekdays) will change to weekdays and the event will occur every weekday
•	Same day every X months (X > 2) will change to monthly
•	Same weekday every X months will change to monthly same weekday
•	Same weekday yearly will merely change to yearly, same date.
To facilitate the most reasonable mapping, the original recurrence pattern will be appended after the Location field in text. For example, if the original Location field is "Roy’s Office", after appended with the recurrence information, it will read as "Roy’s Office. Recurrence on the same weekday every 3 weeks."
Task considerations
•	"Low priority" is not supported. It is considered normal priority.
•	Due date is always set to 11:59:59 PM on the same day.
•	Reminder time is converted from an accurate time point ( for example, Tue 9/11/01, 8:00 AM) to an equivalent time (such as hours or minutes) before due time (for example, Time before due date: 1 hour). 
Private distribution list considerations
•	The note text and attachments are not supported.
•	The list member is represented by its SMTP address until it is migrated. If it does not have an SMTP address, it is ignored, and the member is permanently removed from the list.
Private mail user considerations
•	Attachments are not supported.
•	Long note text is not supported. Only 4 or 5 lines can be migrated from the Notes field (on the Microsoft Exchange Server Contact form). 
•	Quotation marks are replaced with asterisks (*) within the note text.

�Appendix A: Migrating user information from Microsoft Exchange Server to FirstClass using FirstClass®  Migrator for Microsoft Outlook® 
FirstClass®  Migrator for Microsoft Outlook®  migrates mailbox content from Microsoft Exchange Server to FirstClass. It migrates one or several personal message stores (appearing as .PST files) and your Microsoft Exchange Server mailbox (located within the Exchange Server's private message store) into your FirstClass account. 
Appointment and task items from Microsoft® Outlook® are added to your personal calendar in FirstClass, and your personal contacts and distribution lists are added to your FirstClass address book. The private message stores you choose to migrate will appear as folders on your FirstClass Desktop after migration. 
Warning
If neither the private calendar nor address book exists on the user’s FirstClass Desktop, the application will fail. If either of these is not on your Desktop, contact your administrator. 
Note
FirstClass Migrator does not migrate the Deleted Items folder from Microsoft Outlook. This is a good repository for storing items temporarily that you do not want migrated.
Installation requirements
•	Microsoft 32-bit Windows platform (Windows 95 or higher or Windows NT 4.0 or higher)
•	Intel Pentium CPU
•	64 MB memory
•	Microsoft Outlook 2000 (or Microsoft Outlook 97/98 with Internet Explorer 5.0 or higher)
•	FirstClass Client 6 or higher
•	Connection to FirstClass 6 Server or higher
•	Connection to Microsoft® Exchange Server 5.5
Using FirstClass Migrator for Microsoft Outlook
1	Gather the following information before you run the application (fcmc.exe):
Note
You may need to ask your FirstClass administrator for some of the information.
•	your FirstClass user ID and password
•	the name of your organization's FirstClass server or its IP address.
2	Start Microsoft Outlook.
This action will make the message stores available for and automatically provide login information to FirstClass Migrator for Microsoft Outlook.
Warning
Make sure your FirstClass Mailbox has a disk quota greater than the size of your Microsoft Outlook mailbox. If you cannot achieve this, remove some messages from your Microsoft Outlook mailbox to make it fit your FirstClass disk quota. Otherwise, some content from the Microsoft Outlook mailbox will fail to migrate. 
If you encounter this situation, you will receive an error message, with the option to terminate the migration immediately, or ignore the message and resume the migration.
3	Start the FirstClass Migrator for Microsoft Outlook.
You will be prompted for:
FirstClass Account User ID	
Enter your user ID (or the user ID of the person whose information you are migrating).
FirstClass Account Password	
Enter your account password (or the password of the person whose information you are migrating).
FirstClass Server name or IP address
Enter the domain name or IP address of the FirstClass server.
If you are using Internet Explorer proxy settings, select "Use Internet Explorer Proxy Settings". Your administrator should tell you in advance (when you are gathering the information) if this option should be selected.
Generally, if there's no proxy server (firewall) sitting between your machine and the FirstClass server, this field should be left at its default value of  "0.0.0.0 : 1080", meaning a direct connection. If your machine sits behind a proxy server (firewall), and accesses a remote FirstClass server, the proxy settings must be configured. You can usually rely on the proxy settings that were used to configure Internet Explorer on your machine. If this does not work, you can input the proxy settings manually from the information you gathered in the first step. 
Note
You can click About to find out application information such as version number and copyright.
4	Click Next when finished.
You will see the Select Message Stores window.
Double-click to enlarge:
[Image:29012002_110952_17.png]
5	Select the message stores to migrate. 
You will see all of the message stores created for your profile. You are only able to select the personal and private message stores. You do not have access to the public message store. 
6	Click OK when you have selected the message stores you wish to migrate.
You will receive a warning for any message stores that have been previously migrated.
When the migration starts, you will see the results of the migration inside a progress window on the main FirstClass Migrator for Microsoft Outlook window. You can stop the migration at any point by clicking Abort. 
When the migration has completed, you will receive a message indicating the migration was successful.
In the list pane window, if you notice any "Failure" messages, these are due to limitations with FirstClass Migrator for Microsoft Outlook . What this means is the object was migrated, but some fields may have been too long, and were therefore truncated. For a list of current limitations, see the FirstClass® Migrator for Microsoft Outlook® ReadMe.



